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Methods to strengthen tissue by introducing chemical bonds (non-enzymatic cross-linking) into structural proteins (fibrillar collagens) for therapy
include photochemical cross-linking and tissue cross-linking (TXL) methods. Such methods for inducing mechanical tissue property changes are
being employed to the cornea in corneal thinning (mechanically weakened) disorders such as keratoconus as well as the sclera in progressive
myopia, where thinning and weakening of the posterior sclera occurs and likely contributes to axial elongation. The primary target proteins for
such tissue strengthening are fibrillar collagens which constitute the great majority of dry weight proteins in the cornea and sclera. Fortuitously,
fibrillar collagens are the main source of second harmonic generation signals in the tissue extracellular space. Therefore, modifications of the
collagen proteins, such as those induced through cross-linking therapies, could potentially be detected and quantitated through the use of
second harmonic generation microscopy (SHGM). Monitoring SHGM signals through the use of a laser scanning microscopy system coupled
with an infrared excitation light source is an exciting modern imaging method that is enjoying widespread usage in the biomedical sciences.
Thus, the present study was undertaken in order to evaluate the use of SHGM microscopy as a means to measure induced cross-linking
effects in ex vivo rabbit sclera, following an injection of a chemical cross-linking agent into the sub-Tenon's space (sT), an injection approach
that is standard practice for causing ocular anesthesia during ophthalmologic clinical procedures. The chemical cross-linking agent, sodium
hydroxymethylglycinate (SMG), is from a class of cosmetic preservatives known as formaldehyde releasing agents (FARs). Scleral changes
following reaction with SMG resulted in increases in SHG signals and correlated with shifts in thermal denaturation temperature, a standard
method for evaluating induced tissue cross-linking effects.

Video Link

The video component of this article can be found at https://www.jove.com/video/56385/

Introduction

Progressive myopia is postulated to be treatable through non-enzymatic scleral cross-linking (photochemical and/or chemical), which makes
sense %iven that blocking collagen enzymatic cross-linking can increase experimental form deprivation (FD)-induced myopia1. Elsheikh and
Phillips® recently discussed the feasibility and potential of using standard ultraviolet-A irradiation (UVA)-riboflavin mediated photochemical cross-
linking (also known as the Dresden protocol), abbreviated here as (riboflavin CXL) for posterior scleral stabilization to halt axial elongation in
myopia. This photochemical method has been successfully used for treating destabilization of the anterior globe surface (i.e., the bulging cornea)
seen in keratoconus and post-LASIK keratectasia. However, application of this CXL protocol for the sclera is hindered by issues related to
difficulties in accessing the posterior sclera with an ultraviolet (UV) light source, as well as the need to modify a much greater tissue surface area.
That being said, the CXL approach has been used to halt axial elongation in visuallg form deprived rabbits (by tarsorrhaphy), although multiple
regions of posterior sclera required multiple separate irradiation zones in that study”. By contrast, injection of a chemical stabilizing agent (i.e.,
cross-linking agent) via the sT space could represent a simpler way to modify the posterior sclera, avoiding the need for introducing a UV light
source. This injection technique is well known as a useful way of inducing ocular anesthesia during ophthalmologic procedures such as cataract
surgery4'5’6. Wollensak’ has described previously the use of an sT injection using glyceraldehyde (a chemical cross-linking agent similar in
concept to the formaldehg/de releasing agents (FARs) described in this study) to stiffen the rabbit sclera and genipin has been shown to limit axial
length in FD guinea pigs' 9 These investigators have demonstrated a clear advantage of using a soluble chemical agent over the photochemical
CXL technique. Thus, scleral cross-linking using an injectable chemical agent of some type, including the FARs (i.e., TXL)1°, could provide a
feasible treatment method to halt the progression of scleral elongation seen in myopia.

In the protocols presented here, we use a chemical cross-linking solution of sodium hydroxymethylglycinate (SMG), delivered via sT injection to
the sclera of cadaveric rabbit eyes. We have implemented similar protocols previously for topical chemical cross-linking in the cornea. Notably
in those previously reported studies, concentration dependent cross-linking effects could be obtained using SMG, with an effect range spanning
well above that achievable with photochemical CXL as determined by thermal denaturation analysis“.
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Here we describe protocols to assess the cross-linking effect of SMG delivered via sT injections to scleral tissue, thermal denaturation using
Differential Scanning Calorimetry (DSC), and Second Harmonic Generation Microscopy (SHGM).

Using differential scanning calorimetry (DSC), also known as thermal analysis, a thermal denaturation transition is measured, which for scleral
tissue is predominately guided by the properties of the fibrillar collagens, since they constitute the bulk majority of protein. This method evaluates
the stability of collagen molecular structure and the cross-linked bonds that stabilize the collagen fibrils, the principal tertiary protein structure.
During heating in the DSC, a critical transition temperature is achieved that results in denaturation of the collagen molecule, resulting in uncoiling
of the triple helix, a process that forms what is commonly known as gelatin. This thermal denaturatlon dlsrupts hydrogen bonds along the
collagen molecule and can be shifted to higher temperatures through induced cross-linking methods'?'3. This method has been used for many
decades, particularly in the biomaterials industry and for processes that include leather-making. However, this method requires extraction of the
sclera tissue and therefore can only be useful as an ex vivo technique.

Second-harmonic generation microscopy (SHGM) is based on the non-linear optical properties of particular materials, with non-centrosymmetric
molecular environments. In such materials, intense light, for example light produced by lasers, generates SHG signals, in which the incident
light is doubled in frequency. Biological materials that are known to create SHG signals are collagen, microtubules, and muscle myosin. For
example, collagen excited with an infrared light of 860 nm wavelength will emit an SHG signal in the visible range with 430 nm wavelength.
Second harmonic generation (SHG) signal imaging is a promising method for evaluating therapeutic collagen cross-linking. It has been known
for more than 30 years that collagen fibrils in tissues emit SHG S|gnals However, only recently could high resolution images be obtained™ in a
variety of tissues, including tendon16 skin, cartllage17 blood vessels'® ,and in collagen gels .

Based on this knowledge, this study evaluates the SHG signal changes induced in the sclera through SMG chemically induced cross-linking of
collagen. The results indicate that SMG modification of the sclera increases the SHG signals produced from tissue collagen fiber bundles (the
higher order quaternary structure comprised of collagen fibrils) and also produces a structural morphologic change in the collagen fiber network,
reflected in fiber bundle "straightening."

All procedures were performed using cadaveric rabbit eyes within intact outbred rabbit heads. All Institutional and National guidelines for the care
and use of laboratory animals were followed.

1. Preparation of Solutions

1. SMG preparation for TXL:
1. Prepare 1 mL of 0.2 M concentration of sodium bicarbonate solution (NaHCO3) solution using 0.0165g of NaHCO3 powder dissolved in
1 mL of the distilled water.
2. Dissolve 0.1016 mg of powdered sodium hydroxymethylglycinate (SMG) in 1 mL of the distilled water to get a final concentration of 800
mM SMG. Adjust sodium bicarbonate solution to a final concentration of 0.1 M NaHCO3; and 400 mM SMG. Concentrations of SMG
depending on the cross-linking effect desired. In the protocol described here we used 40, 100, and 400 mM SMG.

2. SubTenon's Injection for TXL using SMG

Fill two 1 mL insulin syringes (25G needles) with 400 pL control and SMG solution, respectively.

Place the rabbit's head in a profile plane with the help of a cushion. Styrofoam or a paper stack can be used to fix the head in an optimal

position.

Retract the eyelids with a pediatric eye speculum.

Measure the initial intraocular pressure (IOP) using an applanation tonometry device.

Mark the site of intended injection on the upper middle part of the limbus with a tissue marker.

Retract the conjunctiva surrounding the site of injection with a conjunctival forceps (or any forceps with serrated round tip) and insert the

needle through the conjunctiva, entering Tenon's capsule just slightly beyond the marked limbal site (i.e., 2-3 mm from the limbus). A small

incision in the conjunctiva can also be made with iris scissors in order to facilitate the passage of the needle through Tenon's capsule.

7. Once within Tenon's capsule, make sure that the needle is freely mobile by moving it side-to-side. During this time, the globe should not
move. This confirms proper placement of the needle above the sclera in the sub-Tenon's (sT) space.

8. Inject the solution from the syringe and discard the needle. Immediately following injection, the fluid will accumulate in the sT space creating
an anterior bulge seen through the conjunctiva (i.e., chemosis).

9. Repeat the IOP measurement in order to confirm that it did not change due to an inadvertent perforation of the globe.

10. Remove the lid speculum, and perform digital massage through the closed eyelids for about 2-3 min.

11. Leave the head for an incubation period of 3.5 h (room temperature = 18 °C), prior to moving to the next step.

N =
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3. Tissue Preparation

1. Retract the eyelids using the eyelid speculum in order to optimize access to the globe. Select the optimally sized speculum according to the
size of the eye.

2. Separate the conjunctiva surrounding the limbus. If it has already been incised near the site of injection, circumferentially expand the borders
so it would contain an inoculum size of approximately 1x1 cm.

3. Cut the extra-ocular muscles at their sites of scleral insertion.

4. Elevate the eyeball with forceps, pushing it from the posterior side. This provides access to the posterior globe and will facilitate cutting of the
optic nerve with ophthalmic artery and vein located near the posterior pole of the globe.
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5. Cut out the corneoscleral complex, with the outer border including the marked injection site. The stain should still be visible on the remaining
part of the sclera.

6. Remove the corpus vitreus and all layers attached to the inner side of the sclera by applying traction with tissue forceps.
NOTE: Further steps depend on the following procedures being performed: 4.-DSC analysis, 5.-SHG microscopy.

4. For Regional DSC Analysis

1. For the treated eye: cut out four scleral sectors from the remaining scleral cup with the scissors so that the site of the injection is located in
the upper sector and aligned centrally. Cut the remaining 3 sectors from both lateral sides (i.e., nasal and temporal), and the bottom.
NOTE: the numbering of the sectors (1-4) which are further divided into squares (1-16) is demonstrated in Figure 1A.

2. Cut the scleral sectors (1-4) into smaller squares (1-16) of approximately 4 x 4 mm each. Sector 1 should be divided into 9 squares (make the
exact site of injection an individual square [square 2]). Divide sectors 2 and 3 into 2 squares each (squares 10-11 and 12-13) and sector 4
into 3 squares (squares 14-16).

3. Assign a number to each square, as shown in Figure 1A, in order to localize the distance of the analyzed tissue from the location of the
injected area.

4. For the control eye: after dividing the tissue into four scleral sectors (similar to the treated tissue) cut out square pieces of tissue from the
following locations: 3 squares from the top sector (sector 1), 1 from each side (sectors 2 and 3), and 1 from the bottom sector (sector 4).

5. Scrape off the remaining retinal and choroidal layers and wash twice with fresh PBS each time, leaving the pieces submerged in solution for
approximately 10 s at a time.

5. For SHG Imaging

Cut the upper part of the sclera using scissors to create a 1 x 1 cm area with the site of injection aligned centrally.

Scrape off the remaining retinal and choroid layers and wash twice with fresh PBS each time leaving the pieces in solution for approximately
10s.

3. Place the tissue in 1 mL tubes filled with PBS solution for transportation to the imaging facility. All the procedures, following the incubation
time and beginning with the dissection of the eyeball should be performed within an hour.

N =

6. Microscopy Protocol

NOTE: This protocol for imaging back-scattered SHG signal from collagen of sclera tissue is tailored for the laser scanning microscope.

1. Microscopy set up

1. To maximize the signal and resolution when performing SHG microscopy use an objective lens optimize to transmit infrared light and

with a high numerical aperture (NA). Our objective is Nikon Apo LWD 25x/NA1.1 water immersion.

2. Adjust the correction collar of the lens to match the depth of the sample, in this case that is the thickness of the coverslip, 0.17

millimeters.

3. Mount the 25x objective lens and add a generous amount of lubricating water-based gel to cover the imaging surface before mounting

the sample. The water-based gel will not evaporate during the experiment and hence will maintain image quality.

4. Place the scleral tissue from a 1 mL tube with PBS without drying between two 25-mm round coverslips (episcleral side down)

providing maximal contact between the episclera and the coverslip surface.
NOTE: The tissue can also be placed uncovered on the coverslip. A good amount of PBS should keep the tissue hydrated during
imaging. In this case, add the tissue piece and the PBS after assembling the cellchamber.

5. Assemble the cell chamber by placing a 25-mm round coverslip, single or in a sandwich technique, on the bottom part of the chamber
and screw the top part down in order to create a sealed round chamber. Do not screw down tightly when a top coverslip is used, in
order to avoid artificially flattening and damage the tissue.

Mount the cell chamber with the tissue sample on the microscope stage.

Set the microscope for eye view with transmitted light on.

Position the stage and adjust the height of the objective such that the lower surface of the sample is in focus, as determined by bright

field inspection through the eye piece.

9. Turn off all lights except the computer monitor and block as much light from the monitor as possible with aluminum foil sheets draped
on the microscope stage. Minimizing any stray light reaching the detectors will ensure low-noise acquisition, as the GaAsP NDD
detectors have high sensitivity.

10. In the Ti Pad panel of the software, check that the lens definition is correct.

11. In the A1 Compact GUI panel, choose the IR laser for imaging, select the NDD detectors and choose the DAPI channel that is
equipped with a 400-450 nm bandpass filter.

12. In the A1 MP GUI panel, set the wavelength of the infrared laser to 860 nm and open the shutter.

13. Set laser scanning conditions in the A1 Compact GUI panel as follows. Select: (a) Galvano scanner, (b) Unidirectional scanning, (c)
Pixel dwell time 6.2 ps, (d) Frame size 1,024 x 1,024 pixels, (e) Line averaging 2x
NOTE: The Galvano scanner and unidirectional scanning ensures precise point by point alignment. A size of 1,024 x 1,024 for the full
field of view translates into a pixel size of 0.5 uym /pixel. Line averaging will reduce the shot noise in the image.

14. Set imaging conditions in A1 Compact GUI panel by adjusting laser power and detector gain. Open the Look Up Table panel (LUTs)
that displays a histogram of pixel intensity values in the current image. Turn on live imaging in “Find” mode and maximize the detected
range of pixel values by adjusting laser power and detector gain. Avoid saturation. Typical values are 2.5% laser power, from a total of
2.35 W at 860 nm, and 100 HV (detector gain).

15. NOTE: For this setup, the laser power measured with an internal power meter is 5.2 mW. Every time an experiment is performed, re-
adjust the laser percentage such that the internal power measurement is constant at 5.2 mW between imaging sessions. Care should

oNo
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be taken when setting laser power. The Chameleon Il laser is a 3 W laser at 800 nm and a 10% or higher power could potentially
induce tissue damage.

2. Image acquisition

1. In preview mode, scan the tissue area using the XYZ Overview tool.

2. Setthe imaging to lower resolution (256 x 256 pixels and no line averaging) to speed up the acquisition of images in this mode.

3. Capture 5 x 5, 3 x 3, or single fields of view to cover the entire surface of the tissue. At each location, before the overview capture, turn
on the live "Scan" mode and bring the tissue into focus. Note that different regions of the tissue will have slightly different positions in
the axial direction.

4. Find a flat area where the collagen fibers are seen in the entire field of view and double-click that position in the overview tool to move
the stage to that particular location.

5. Turn on live "Scan" mode, adjust the Z position of the objective such that the bottom plane is in focus and, in the Ti Pad, use the Z drive

to move the optical plane 10-15 uym above this bottom layer.

Acquire an image at high resolution with 1,024 x 1,024 pixels and 2x line averaging, using the "Capture" button.

Save the location in the XYZ Overview using the "+" button. This ensures that the same area of tissue is not recaptured.
For each piece of tissue capture 10 images of non-overlapping fields of view.

oN®

7. DSC Protocol

Note: Proceed to this step as soon as tissue preparation is complete, for regional DSC analysis, or after tissue imaging when SHGM is
performed.

1. Prepare DSC pans, weighed and labeled.

NOTE: This step should be done before tissue dissection in order to minimize tissue desiccation.

2. Dry each scleral square with an absorbent tissue and lay it flat on the bottom of a DSC pan using toothed forceps.

3. Weigh the pan with the tissue inside and lid crimped and covered to obtain the tissue wet weight (mass of the samples should be in the range
of 5to 11 mg).

Note: Seal each pan using the crimper before proceeding to the next tissue sample. The pans are hermetically sealed, preventing any water
loss prior to thermal analysis.

4. Once the sample is crimped, place it on its designated location on the DSC tray. There should be 6 samples for the control and 16 for the
treated eye.

5. Create a method using instrument managing software, specifying the weight of the tissue, and run the thermal analysis using the following
parameters: Temperature range of 40 to 80 °C, Heating rate: 1 °C/min, Heat flow: 17.37 mW, Gas (N,) flow: 19.8 mL/min, Gas pressure: 2.2
bar.

6. Once completed, analyze the data for each sample by extracting the transition temperature peak at which thermal denaturation occurs using
the instrument managing software.

8. Image Analysis

1. SHG Signal

1. Select at least 5-10 of the most representative images from each treatment and its control, such that the area of the image is occupied
by mostly collagen fibers.

2. Upload each image in ImagedJ software and measure the average pixel intensity by selecting Analyze> Measure for the active image.

3. The values extracted are reported as the mean pixel intensity and can also be shown by plotting the histogram of intensities by
selecting from the menu Analyze > Histogram.

4. Using an Excel sheet, create a table to document all measured data accordingly to the sample ID.

5. Calculate the mean and standard deviation of pixel intensity for each treatment and control condition.

6. Using student's t-test, compare differences for all pairwise comparisons of concentrations (i.e., 40 mM SMG vs. 0 and 400 mM SMG
vs. 0). [P<0.05].

2. Waviness

1. Select an image that displays collagen fibers. At least 10 images per sample should be analyzed (including a control sample for each
concentration - at least 40 in total).

2. Open ImageJ>Plugins> Neurond. NeuronJ requires prior installation.

3. Upload all imagesby dragging into an opened NeuronJ window.

4. Create tracing lines along the fibers, following the contour of the fibril with the mouse (pen drawing tablets could be used), click M to
measure the distance of total fiber length.

5. Select "Option" to draw a tangential straight line and connect the beginning and the end of the previously drawn fiber contour. Now click
M to measure the end-to-end length.

6. Repeat the same procedure on at least 10 fibrils per image.

7. Collect those two measurements from each of 10 fibrils and input the data into an excel spreadsheet, expressing total fiber length
(contour) and end-to-end length (straight connecting line) as Length [curve] and Length [linear], respectively.

8. Calculate the waviness index (W) using the formula: W= Length [curve]/ Length [linear].

9. Calculate the % of waviness comparing data from the images of treated samples(SMG) with the images from control samples using the
formula: (W[SMG] - 1) / ( W[control] - 1)
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10. Perform a pairwise t-test for waviness index (W) in order to determine statistical differences (p-values) of collagen fiber morphology
between different treatment conditions and control.

Representative Results

Thermal denaturation temperature (Tm) as an assay method to evaluate TXL cross-linking effect: A total of 16 pairs of rabbit eyes
were used in these experiments for the TXL procedure.As an initial part of this study, the localization of cross-linking effect induced by a single
injection of SMG cross-linking agent via sT space in the cadaveric rabbit head was evaluated. This type of experiment has relevance to the
clinical treatment of patients, since injections in more than one location could be necessary to stabilize a desired area of sclera.

As would be predicted based on basic diffusivity principles, the effect was greatest at the site of injection with effects induced in adjacent
regions as well, depending on the concentration of the solutions. Figure 1A represents the schematic location of scleral sectors (1-4 in red
hollow number font) (further divided into squares (1-16 in black thin number font)) that underwent separate thermal denaturation analysis
following a single sT injection with color mapping index. Table 1 shows the change in Tm values for each numbered sector as compared to
its corresponding control. Values are included for both 40 mM and 400 mM injections and include standard error of the mean calculated for a
minimum of three independent determinations.

Figures 1B-C represent the results using two different concentrations of SMG, 40 mM (Figure 1B) and 400 mM (Figure 1C). In Figure 1B,
the lower concentration 40 mM sample showed a mild shift in Tm which was noted in square 2 (the injection site). Similar shifts were seen in
adjacent squares 1 and 3 (lighter blue). Marginal shifts are seen in squares 4 to 6 and 7 to 9 without statistically significant differences from the
injected square. No Tm shift was seen in the lower squares 14 to 16, which represented the most distant sector away from the injection site.

As shown in Figure 1C, the higher concentration (400 mM) had a statistically highly significant cross-linking effect (indicated as shades of
orange). A large shift in Tm with associated small standard deviation and p< 0.05 were observed, reflecting a large difference in the effect

of the 400 mM compared to lower 40 mM concentration. The most dramatic effects were noted in sector 1 in the upper globe. With regard to

the remaining sectors, a lesser effect was observed in squares 10 and 14 (which may have been due to some tracking of cross-linking fluid
posteriorly) and no effect was observed in squares 11, 12, 13, 15, and 16. Overall, the cross-linking effects were marginal in sectors 2 and 3 with
no effect observed in sector 4 (i.e., the most distant location from the injection site), similar to the 40 mM sample. These results indicated that
there was a "zone of effect" and that this type of pattern could be expected following a sT injection of cross-linking agent. This could indicate the
need for injection in several locations in order to induce effects over a wide area of tissue.

Study of the cross-linking effects induced in intact eyes evaluating TXL with two concentrations of SMG was also performed. Thermal
denaturation analysis of tissue that underwent such scleral cross-linking was performed. Cross-linking time was 3.5 h for TXL using three
different concentrations, 40 (Tm=1.11+/-1.2), 100 (Tm=5.12+/-2.9), and 400 (Tm=14.34+/-1.1) mM SMG. The results showed that there is a
concentration dependent effect seen in SMG cross-linked tissue.

Second harmonic generation (SHG) imaging as a method to evaluate TXL cross-linking effect:

SHG microscopy images were analyzed both for pixel intensity of the SHG signal and fiber bundle waviness. A wide span of cross-linking
concentrations (from 40 to 400 mM) was used in order to explore the SHG signal changes that may occur over a wide range of cross-linking
effects. Using the histogram analysis capability included in the Fiji image processing programzo, it was possible to quantitate the SHG signal
produced in scleral tissue by sT injection, comparing the effects at 40 mM to those induced using 400 mM. The average difference in mean pixel
intesities at 40 mM were 66.3 £ 27.7 compared to 361.4 + 28.3 for the 400 mM samples, a nearly 6-fold increase. This corresponds with an
increase in tissue cross-linking, since corresponding increases in Tm also were noted under these conditions. Figure 2 shows representative
SHG images of sclera taken from control (Figure 2A), 40 mM (Figure 2B), and 400 mM (Figure 2C). The accompanying histogram analysis,
including mean brightness (or pixel intensity) is also shown. The total number of images analyzed was: 120 for 40 mM and 98 for its control; 121
for 400 mM and 94 for its own control. The depth of tissue imaging was 10 to 15 ym from the episcleral surface. The results of the histogram
analyses, which involved the averaging of numerous image fields, indicated that higher concentrations of cross-linking effect (Figure 3) produced
greater pixel intensities.

As shown in Figure 4, an image analysis was also performed with methods adopted from the cardiovascular blood vessel literature, using the
Imaged plugin "Neuron J" ', We estimated the waviness factor W=Length[curve]/Length[linear] and we observed that cross-linking resulted

in straightening of fiber bundles as indicated by a decreased waviness % in 40 mM and 400 mM cross-linked sclera versus untreated control
sclera (W%=(W[SMG]-1)/(W[control]-1), Table 2). The difference in waviness between 40 and 400 mM SMG treated samples was not statistically
significant.
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Figure 1: Localization of TXL effect via sT injection using 40 and 400 mM SMG.

(A) Schematic representation of 4 scleral sectors (numbers 1-4 in large red hollow font), with sclera divided into squares [numbers 1-16 in
smaller black thin font] (not drawn to scale) that underwent thermal analysis. The injection site corresponded to the centrally located square
(square 2) in sector 1. The thermal denaturation cross-linking effect of TXL with (1B) 40 mM SMG and (1C) 400mM SMG. (D) Color coded
temperature scale legend for (B) and (C). This figure has been modified from Zyablitskaya et al. with permission22. Please click here to view a
larger version of this figure.

Figure 2: Representative images of concentration dependent increases in SHG signal brightness levels produced following TXL using
SMG via sT injection of sclera ex vivo. Concentrations of SMG are shown as (B) 40mM and (C) 400mM. Each image contains a 50 ym scale
bar (right lower corner) and mean pixel intensity value (right upper corner) - absolute values. This figure has been modified from Zyablitskaya et
al. with permissionzz. Please click here to view a larger version of this figure.
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Figure 3: Bar chart of the change (A) in SHG signal pixel intensity (as compared to a paired control from the same rabbit head) in
scleral intact globes cross-linked via sT injection (TXL) with 40 and 400 mM SMG solutions. Average values with standard error of the
mean were: 66 + 27.7 for 40 mM and 361 + 28.3 for 400 mM. This figure has been modified from Zyablitskaya et al. with permission22. Please
click here to view a larger version of this figure.

Figure 4: Example of fiber waviness analysis (as expressed by linearity). Image of control sample for 40 mM SMG concentration with a
50 pm scale bar (right lower corner). This figure has been modified from Zyablitskaya et al. with permissionzz. Please click here to view a larger
version of this figure.
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Figure 5: Schematic representation of sT injection. Areas numbered 1-3 correspond to areas represented in the Figure 1A. Please click here
to view a larger version of this figure.

+A Tm
area 40mM 400mM
1 34 2.8 20.5 +0.6
2 3.4 +0.53 19.58 +1.5
3 2.5 247 17.99 +3.06
4 0.72 +0.9 20.36 +0.19
5 0.85 +0.55 19.11 +1.33
6 0.52 +1.35 18.66 4.1
7 0.78 +1.6 18.44 +2.8
8 0.56 +0.9 17.77 £2.69
9 0.22 +0.6 18.92 +2.6
10 0.46 0 8.75 £10.56
11 0.47 +0.18 0.63 +1.84
12 0.11 +0.08 0.66 £1.52
13 0.08 +0.05 0.71 £2.17
14 0.22 +0.7 5.71 +0.29
15 0.32£0.2 0.29 +0.7
16 0.24 +0.73 0.26 +0.79

Table 1: DSC results for localization of TXL effect study. Change in thermal melting temperatures (ATm) with standard errors for each sampled
sector is as depicted in Figure 1A. Each value is expressed as the difference in Tm ascompared to its paired control and is an average of a
minimum of 3 independent determinations.

SMG, mM Waviness Waviness-% t-test vs. [0 mM SMG]
0 1.106 £ 0.044 100

40 1.067 £ 0.017 63 p <0.02

400 1.059 £ 0.009 55 p <0.003

Linear fibers 1.000 0

(Theoretical)

Table 2. Results of fiber waviness analysis. SHG images from the area of TXL injection were analyzed for degree of fiber waviness using Neuron
J software. Ten fibers were selected from each image and a total of approximately 100 fibers were analyzed for degree of waviness. Average
values with standard error of the mean are included.
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Conducted experiments have shown evidence supporting the use of SHG signal microscopy as a method for evaluation of collagen cross-linking
effects in sclera, raising the future possibility of using this technique as a monitoring tool for cross-linking treatments that target collagen proteins.
Of note, an instrument already is in clinical use that can potentially capture this SHG si%nal. Although this instrument was primarily designed for
imaging skin human dermis, it has been used successfully to image cornea and sclera®.

It is necessary to maintain identical scanning and imaging conditions when comparing control and treated samples. Second harmonic generation
microscopy of collagen in sclera tissue requires a fluorescence microscope compatible with multi-photon imaging, a pulsed infrared laser tunable
in the 800-900 nm wavelength range, and a highly sensitive detector such as the GaAsP non-descanned (NDD) detectors. Guidelines described
in this manuscript are a starting point. The conditions should be determined specifically for the new experiments or for the different systems.

The cornea and sclera also have been evaluated concurrently in studies using this technique24‘25’26’27. Knowing that the SHG signal propagates

in both forward and backward directions, several studies have examined corneal tissue independently in its native state?®293031323334 g4 in
keratoconus®>®® as well as following CXL (as discussed below). The results of these studies indicate that the corneal signal is optimized in the
forward scattered direction, which makes sense given the cornea's transparency and the fact that light passes through the tissue to strike a
monitor in forward scattered systems. Typically, the SHG signal is in the blue visible range and will be greatly reduced when passing through a
highly scattering tissue like the eye sclera. As a result, detection of the forward scattered SHG would require a thin section of tissue of 50 pm
or less in thickness, as well as a special optical set-up. In contrast, the back-scattered signal can be captured through the regular light path of a
fluorescence microscope without tissue sectioning and therefore this mode is preferred when imaging collagen in intact sclera tissue to a depth
of 30-40 ym. In this study, we noted a concentration dependent increase in signal density. It is quite possible, however, that the TXL might have
had additional and similar effects on deeper layers of the sclera, and that the effect could be more pronounced and extend to deeper layers
particularly with the higher concentration. However, due to the limited SHG signal penetration in the sclera and for the purposes of this initial
study, we chose to work with the best quality images, which were obtained from the most superficial sclera (15 um depth). In future studies,

we will consider depth dependent effects following TXL methods as this may provide additional important information as to why even greater
differences were not observed between 40 and 400 mM treated samples.

Furthermore, regarding the use of SHG for evaluating riboflavin CXL induced tissue cross-linking, SHG microscopy imaging following riboflavin
CXL of the cornea have been reported by several groupsa7'38’39'40'41. In a study by Steven et al.>’, corneal stabilization using the CXL technique
resulted in a "homogenization" of signal and loss of tissue "folds" or "undulations" seen in non-cross-linked samples. These types of changes,
however, also were noted in a study evaluating the effects of changes in IOP on corneal SHG signals, raising the possibility of technical
artefacts. Organizationally from the fibril as well as the higher order fiber bundle/lamellar organization standpoint, the sclera and cornea are
quite different and much is known about such differences from electron microscopy studies.The two tissues differ with regard to fibril packing,
which includes fibril diameter distribution (small uniform fibrils for the cornea and variable diameter fibrils for the sclera) and inter-fibril spacing
(uniform for cornea and variable for sclera). As well, the higher order organization into lamellar sheets (cornea) versus fiber bundles (sclera) is
quite different. Such structural differences are reflected in the SHG signals produced by these two tissues. Thus, changes induced by cross-
linking may alter the SHG signal in different but parallel ways. In other words, the "straightening" of fibers in the sclera observed in this study,
and the "homogenization" of signal in the cornea reported in the literature, were both the result of collagen cross-linking modification. Thus, the
"homogenization" effect in the cornea could in some way be analogous to the "straightening” effect of the sclera that has been reported here.

The mechanisms that result in this straightening effect produced by TXL are unclear based on the current study. One possibility could be that

the tissue was somehow "fixed" in a mechanically "loaded" position.This would support the notion that induced "fibril and fiber stabilization" had
occurred. Changes in intraocular pressure likely did not contribute to this effect since IOP was monitored prior to and following the sT injection
and remained stable. Overall, the significance of these observations are unclear and further studies will be necessary. Of note, separate imaging
techniques such as Brillouin microscopy42, which has been shown to provide quantitative measures of cross-linking (as determined by shear
modulus) following CXL photochemistry may be useful in confirming the findings with SHG imaging in this study. However, it should be noted that
its use with highly scattering tissues such as the sclera®, requires technical modifications and has not been validated with cross-linked scleral
tissue.

Laser polarization and SHG microscopy is an important issue. The laser light is linearly polarized and oriented perpendicular to the direction of
SHG signal propagation and at some angle in the xy-plane to each collagen fiber. Thus, fibers in the xy-plane that are well aligned and exactly
perpendicular to the polarized laser light will produce a higher SHG signal than those at other angles, including those parallel to the incident

light (i.e., z-plane), which will produce the lowest SHG signal (due to destructive interference). With respect to sclera tissue, collagen fibers are
oriented at various angles on a microscopic level, although preferred anatomic fiber orientations are known to exist based on globe location.
Thus, since the SHG signal produced will vary depending on the xy-plane angle of each fiber, the overall signal will be less than that which would
be produced if all the collagen fibers were exactly aligned at the same angle (in a tissue such as a tendon, for example). Thus, in this study,

due to the nature of the sample being imaged, the direction of polarization was not intentionally determined but was kept consistent throughout
the study. Furthermore, we took care to obtain tissues from treated and control globes from identical scleral regions, minimizing any differences
in fiber orientation between samples. Finally, we analyzed over 100 images per sample in order to obtain intensity values. This extensive
evaluation should have normalized any aberrant SHG signals that may have been registered. That being said, it is possible that as a result of the
"fiber straightening" that we observed in the cross-linked samples (described above), a greater proportion of "in focal plane" fibers could have
contributed to the increase in the SHG signal as well as increased SHG signals from greater xy-plane alignment. Both of these possibilities would
be manifestations of induced cross-linking effects.

A regional analysis of cross-linking changes (by Tm) induced by an sT injection of SMG was performed. As expected, the level of cross-linking
effect was concentrated in the area of the injection. Little or no cross-linking effect was noted in the region directly opposite (furthest away) from
the injection, consistent with what is known regarding localization of effect following sT injection as shown by ultrasound localization***° and
computed tomography46.
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Finally, regarding cross-linking therapy and myopia, collagen cross-linking of the cornea is finding widespread use in the treatment of corneal
destabilization including keratoconus, post LASIK keratectasias, pellucid marginal degeneration (PMD), and as an adjunct to refractive surgical
procedures”. The success of treating corneal disease with cross-linking has led to the exploration of applying this treatment approach to the
back of the eye and, in particular, the sclera, for limiting axial elongation in high myopiaz, a concept that goes back to the very earliest stages of
the therapeutic cross-linking concept48'49.
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